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About this manual

Audience
This  reference  manual  is  intended  for  IBM® Rational®  Logiscope™   users  such  as  software 
developers, project managers or quality engineers who want to use the Logiscope toolset within the 
Microsoft Visual C++ .NET environment.

Overview
This manual is a complement to the  Rational Logiscope documentation. 

● Section 1 explains what is the content of the integration.

● Section 2 explains how to install the integration.

● Section 3 tours the available functionalities of the integration.

Conventions
The following typographical conventions are used in this manual:

italics names of textual elements (filename), notes, documentation titles.

typewriter screen and file examples.

Contacting IBM Rational Software Support

If the self-help resources have not provided a resolution to your problem, you 
can contact IBM® Rational® Software Support for assistance in resolving 
product issues.

Note.  If you are a heritage IBM Rational customer, you can go to 
http://support.IBM Rational.com/toolbar  and download the IBM 
Rational IBM Rational Software Support browser toolbar. This toolbar 
helps simplify the transition to the IBM Rational IBM Rational 
product online resources. Also, a single reference site for all IBM 
Rational IBM Rational support resources is located at: 
http://www.ibm.com/software/rational/support/IBM Rational/ 

Prequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can 
enroll online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html .
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•    To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs 
_quickguides.html . 

•    For further assistance, contact your IBM representative

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:

•    Be a registered user on the IBM Rational Software Support Web site. 
For details about registering, go to 
http://www-01.ibm.com/software/support/ .

•    Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1)   Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.

Use the following table to determine the severity level.

Severity Description
1 The problem has a critical business impact. You are 

unable to use the program, resulting in a critical impact on 
operation. This condition requires an immediate solution.

2 The problem has a significant business impact. 
The program is usable, but it is severely limited

3 The problem has a some business impact.
The program is usable, but less significant features 
(not critical to operation) are unavailable.

4 The problem has a minimal business impact. 
The problem causes little impact on operations or a 
reasonable circumvention to the problem was implemented.

 

2)  Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers 
to these questions:

•    What software versions were you running when the problem 
occurred?

To determine the exact product name and version, use the option 
applicable to you: 

● Start the IBM Installation Manager and select File > View 
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Installed Packages. Expand a package group and select a 
package to see the package name and version number. 

● Start your product, and click Help > About to see the offering 
name and version number. 

•    What is your operating system and version number (including any 
service packs or patches)? 

•     Do you have logs, traces, and messages that are related to the 
problem symptoms? 

•    Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

•    Did you make any changes to the system? For example, did you 
make changes to the hardware, operating system, networking 
software, or other system components? 

•    Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3) Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

•    Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/  and in the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own 
words.

For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html .

You can also open an online service request using the IBM Support 
Assistant. For more information, go to:  
http://www-01.ibm.com/ software/support/isa/faq.html  

•    By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/  and click the name of your country 
or geographic region. 

•    Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information 
for each country at http://www.ibm.com/planetwide/ .

If  the  problem you  submit  is  for  a  software  defect  or  for  missing  or  inaccurate 
documentation,  IBM  Rational  Software  Support  creates  an  Authorized  Program 
Analysis  Report  (APAR).  The  APAR describes  the  problem in  detail.  Whenever 
possible,  IBM  Rational  Software  Support  provides  a  workaround  that  you  can 
implement until the APAR is resolved and a fix is delivered. IBM publishes resolved 
APARs on the IBM Rational Software Support Web site daily, so that other users 
who experience the same problem can benefit from the same resolution.
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 IBM Rational Logiscope

1. Overview

The integration allows access IBM® Rational®  Logiscope™  functionalities from Microsoft 
Visual C++ .NET graphical environment.

This integration is available for C and C++ Visual C++ projects. 

A Visual C++ project shall be considered as a C project if it contains only C source files. A Visual 
C++ project containing at least one C++ source file shall be considered as a C++ project. 

Once the integration is installed it is possible to:

• Build and visualize QualityChecker results (e.g. source code metrics, components 
complexity rating) from the Microsoft Visual C++.NET graphical environment.

• Check rules and visualize violations from the Microsoft Visual C++.NET graphical 
environment.

• Build instrumented binaries (for test coverage analysis) from the Microsoft Visual C+
+.NET graphical environment.

• Launch Logiscope Studio for a more comprehensive use of Logiscope modules.

• Edit the configuration file for default settings (for instance the set of rule to check).

The integration has been developed and tested with :

• Microsoft Visual C++ .NET 2003 (Microsoft Development Environment 2003 
Version 7.1.3088).

• Microsoft Visual C++ .NET 2005 (Microsoft Development Environment 2005 
Version 8.0.50727.42).

Known Limitations:
• The Logiscope integration does not work properly when running 2 distinct instances of 

Microsoft Visual C++.NET in parallel.
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2. Installation
Before using the IBM Rational Logiscope Microsoft Visual C++ .NET integration, you have first 
to install it.

1. Launch the installer from the Microsoft Windows Start menu: IBM Rational / IBM Rational 
Tools /  IBM Rational Logiscope 6.6 / Visual C++ .NET Integration / Installation

2. One of the following windows appears:

• If only one version of Visual C++ .NET is installed on the computer:

• If more than one version of Visual C++ .NET is installed, choose the Visual C++ .NET 
environments in which you want to install the integration:

3. Choose the options you want to install (by default everything is installed):

• Logiscope Studio : if checked, the corresponding menu item “Logiscope Studio” will be 
added into the Tools menu of Visual C++ .NET, which will allow you to start Logiscope 
Studio from Visual C++ .NET environment.

• Edit Logiscope configuration file : if checked, the corresponding menu item will be 
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added into the Tools menu of Visual C++ .NET, which will allow you to edit the 
configuration file directly within Visual C++ .NET. The configuration file is used to set 
default values which are used to create Logiscope projects.

• Build Logiscope RuleChecker results :if checked, the corresponding menu item will be 
added into the Tools menu of Visual C++ .NET, which will allow you to check rules on a 
Visual C++ project directly from Visual C++ .NET environment.

• Build Logiscope QualityChecker results : if checked, the corresponding menu item 
will be added into the Tools menu of Visual C++ .NET, which will allow you to make a 
quality analysis of a Visual C++ project directly from Visual C++ .NET environment.

• Build Logiscope Instrumented binary : if checked, the corresponding menu item will 
be added into the Tools menu of Visual C++ .NET, which will allow you to build an 
instrumented binary, for coverage analysis, from a Visual C++ project directly from the 
Visual C++ .NET environment.

4. Click on Install for the  integration to be installed.
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3. Using Logiscope from Visual C++

3.1. Building Logiscope QualityChecker Results
Before using this functionality, the project must be cleaned in order to force a full rebuild, or new 
Configuration created for the project (to do so use the Configuration Manager of Microsoft Visual C
++). The configuration may be called Logiscope.

Once this has been done, activate the menu “Tools/Build Logiscope QualityChecker Results” from 
Visual C++. The build starts and Logiscope is activated. Logiscope creates a new Logiscope project 
during the build and produces the QualityChecker results. Once the build is finished the following 
text appears within the output window of Visual C++:

The directory where the QualityChecker report has been generated is indicated, and a link to this 
report is available, using Ctrl+Click on the link will open the QualityChecker report of the project in 
a Microsoft Visual C++ .Net window.

During the build the following files/directories are created:

• <project_name>_audit.ttp located into the project directory is the Logiscope project 
corresponding to the Visual C++ project being processed.

• <target_directory>/Logiscope_audit is the Logiscope repository containing intermediate 
files produced by Logiscope.

• <target_directory>/Logiscope_audit/audit_c for C project  or 
<target_directory>/Logiscope_audit/audit_cpp for C++ project is the Logiscope 
repository containing the HTML report.

3.2. Building Logiscope RuleChecker Results
Before using this functionality, the project must be cleaned in order to force a full rebuild, or new 
Configuration created for the project (to do so use the Configuration Manager of Microsoft Visual C
++). The configuration may be called Logiscope.

Once this has been done, activate the menu “Tools/Build Logiscope RuleChecker Results” from 
Visual C++. The build starts and Logiscope is activated. Logiscope creates a new Logiscope project 
during the build and produces the RuleChecker results. Once the build is finished the following text 
appears in the output window of Visual C++:
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Each violation of a rule is listed and a double click on it opens the source file on the appropriate line 
allowing immediate modification of the source file.

Scrolling down to the end of the output window will show the following text:

A link to the rule violations report is available, using Ctrl+Click on the link will open the 
RuleChecker report of the project in a Microsoft Visual C++ .Net window.

During the build the following files/directories are created:

• <project_name>_rule.ttp located into the project directory is the Logiscope project 
corresponding to the Visual C++ project being processed.

• <target_directory>/Logiscope_rule is the Logiscope repository containing intermediate 
files produced by Logiscope.

• <target_directory>/Logiscope_rule/rchk_c for C project  or 
<target_directory>/Logiscope_rule/rchk_cpp for C++ project is the Logiscope repository 
containing the html report.

3.3. Building Logiscope Instrumented binary
Before using this functionality, the project must be cleaned in order to force a full rebuild, or a new 
Configuration created for the project (to do so use the Configuration Manager of Microsoft Visual C
++). The configuration may be called Logiscope.

Once this has been done, activate the menu “Tools/Build Logiscope Instrumented binary” from 
Visual C++. The build starts and Logiscope is activated. Logiscope creates a new Logiscope project 
during the build and produces an instrumented binary for coverage analysis.

During the build the following files/directories are created:

• <project_name>_test.ttp located in the project directory is the Logiscope project 
corresponding to the Visual C++ project being processed.
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• <target_directory>/<target_name> is the instrumented binary build. Please refer to 
TestChecker documentation for its usage.

Note: The default instrumentation library  which comes with the standard Logiscope distribution in 
the file /instr/lib/vlgtc.lib is compiled using the Multi-Threaded model (the Single-Threaded model 
is no longer supported by Visual C++ .NET 2005). If the application to instrument should be a 
Single-Threaded one you would need to build a new library using the source file /instr/src/vlgtchk.c 
and reference the newly built library using the configuration file (see 3.5 Edit Logiscope 
configuration file).

3.4. Launching Logiscope Studio
Once a Logiscope project has been built, a more comprehensive examination of Logiscope results 
may be achieved by launching Logiscope Studio. Logiscope Studio allows to go deeper in the 
exploitation of the produced Logiscope data and in turn to start Logiscope Viewer for a deep quality 
analysis or TestChecker for running tests and coverage analysis.

To start Logiscope Studio from Microsoft Visual C++ .NET graphical environment activate the 
menu “Tools/Logiscope Studio”.

If more than one Logiscope project have been built from the same Microsoft Visual C++ project, for 
instance a RuleChecker project and a TestChecker project, a dialog pops up to ask which one has to 
be open. This dialog looks like:

Click on the kind of project you want to open with Logiscope Studio.

3.5. Customizing the integration
To customize the integration, you can edit the configuration file in Microsoft Visual C++ .NET 
environment.

Mainly, this file used to setting up:

• the C or C++ dialect for parsing code;

• the default quality model used by Logiscope QualityChecker for quality evaluation, 
default is the Logiscope.ref file delivered with the standard Logiscope distribution in the 
Ref folder;

• the default rule set(s) used by Logiscope RuleChecker for rule checking;

• the default support library used by Logiscope TestChecker to instrument source code 
under test.
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##################################################
# This file is used for Logiscope / VC++ .NET
# integration customization.
##################################################

# Note:
# Into this script the tcl variable $InstallDir refers
# to the current Logiscope installation directory

##################################################
# Logiscope QualityChecker C
##################################################
#  Dialect:
set CAuditDefaultDialect msc70

# Qality Model:
set CAuditDefaultQualityModelFile [file join $InstallDir Ref Logiscope.ref]

##################################################
# Logiscope QualityChecker C++
##################################################
# Dialect / parser configuration file:
set CppAuditDefaultParserConfigFile MFC

# Qality Model:
set CppAuditDefaultQualityModelFile [file join $InstallDir Ref Logiscope.ref]

##################################################
# Logiscope RuleChecker C
##################################################
# Dialect: 
set CRuleDefaultDialect msc70

# Rule set: (Default is the Portability.rsf file from the installation)
set CRuleDefaultRuleSetFile [file join $InstallDir util Portability.rsf]

##################################################
# Logiscope RuleChecker C++
##################################################
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# Dialect / configuration file:
set CppRuleDefaultParserConfigFile MFC

# Rule set:
set CppRuleDefaultRuleConfigFile [file join $InstallDir data audit_c++ 
RuleChecker.cfg]

##################################################
# Logiscope TestChecker C
##################################################
# Dialect
set CTestDefaultDialect msc70

# Support instrumentation library: to be linked with the instrumented binary
set CTestDefaultInstrumentationLib [file join $InstallDir instr lib vlgtc.lib]

# Location of the prototypes of instrumentation functions:
set CTestDefaultInclude "/I\"$::InstallDir/instr/include\" /I."

# set 0 or 1 to turn off or on MC/DC instrumentation
set CTestInstrumentMCDC 1

##################################################
# Logiscope TestChecker C++
##################################################
# Support instrumentation library: to be linked with the instrumented binary
set CppTestDefaultInstrumentationLib [file join $InstallDir instr lib 
vlgtc.lib]

# Ignore file:
set CppTestDefaultIgnoreFile [file join $InstallDir util log_inst.ign]

# Alias file:
set CppTestDefaultAliasFile [file join $InstallDir util log_inst.al]

# Instrumentation Model:
set CppTestDefaultTclFile [file join $InstallDir util log_inst.tcl]

# Location of the prototypes of instrumentation functions:
set CppTestDefaultInclude "/I\"$::InstallDir/instr/include\" /I."
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Notices

© Copyright 1985, 2009
US  Government  Users  Restricted  Rights—Use,  duplication  or  disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM  may  not  offer  the  products,  services,  or  features  discussed  in  this 
document  in  other  countries.  Consult  your  local  IBM  representative  for 
information on the products and services currently available in your area. Any 
reference to an IBM product, program, or service is not intended to state or 
imply  that  only  that  IBM product,  program,  or  service  may  be  used.  Any 
functionally equivalent product, program, or service that does not infringe any 
IBM intellectual property right may be used instead. However, it is the user's 
responsibility  to evaluate  and verify  the operation  of  any  non-IBM product, 
program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, 
contact  the  IBM Intellectual  Property  Department  in  your  country  or  send 
written inquiries to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any 
other  country  where  such  provisions  are  inconsistent  with  local  law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE  IMPLIED  WARRANTIES  OF  NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some  states  do  not  allow disclaimer  of  express  or  implied  warranties  in 
certain transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will 
be  incorporated  in  new  editions  of  the  publication.  IBM  may  make 
improvements  and/or  changes  in  the  product(s)  and/or  the  program(s) 
described in this publication at any time without notice. 
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Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for 
this IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees  of  this  program who wish to  have information  about  it  for  the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual 
use of the information which has been exchanged, should contact: 

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such  information  may  be  available,  subject  to  appropriate  terms  and 
conditions, including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available  for  it  are  provided  by IBM under  terms  of  the  IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any  performance  data  contained  herein  was  determined  in  a  controlled 
environment. Therefore, the results obtained in other operating environments 
may  vary  significantly.  Some  measurements  may  have  been  made  on 
development-level systems and there is no guarantee that these measurements 
will  be  the  same  on  generally  available  systems.  Furthermore,  some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those  products,  their  published  announcements  or  other  publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy 
of  performance,  compatibility  or  any  other  claims  related  to  non-IBM 
products.  Questions  on  the  capabilities  of  non-IBM  products  should  be 
addressed to the suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include 
the  names  of  individuals,  companies,  brands,  and  products.  All  of  these 
names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 
If  you  are  viewing  this  information  softcopy,  the  photographs  and  color 
illustrations may not appear. 
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Copyright license
This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly 
tested under all  conditions.  IBM, therefore,  cannot guarantee or imply reliability, 
serviceability, or function of these programs. 
Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows: 
© (your company name) (year). Portions of this code are derived from IBM Corp. 
Sample Programs. © Copyright IBM Corp. _enter the year or years_. 

Trademarks

IBM, the IBM logo, ibm.com are trademarks or registered trademarks of International 
Business Machine Corp., registered in many jurisdictions worldwide. Other product and 
services names might be trademarks of IBM or other companies. A current list of IBM 
trademarks is available on the Web at:

 www.ibm.com/legal/copytrade.html.

Adobe, the Adobe logo, Acrobat, the Acrobat logo, FrameMaker, and PostScript  are 
trademarks of Adobe Systems Incorporated or its subsidiaries and may be registered in 
certain jurisdictions.

AIX and Informix  are  trademarks  or  registered trademarks  of  International  Business 
Machines Corporation in the United States, other countries, or both.

HP and HP-UX are registered trademarks of Hewlett-Packard Corporation.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. 
in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Macrovision  and  FLEXnet  are  registered  trademarks  or  trademarks  of  Macrovision 
Corporation.

Microsoft,  Visual,  Windows,  Windows  2003,  Windows  XP,  Windows  Vista  and/or 
other  Microsoft  products  referenced  herein  are  either  trademarks  or  registered 
trademarks of Microsoft Corporation.

Netscape  and  Netscape  Enterprise  Server  are  registered  trademarks  of  Netscape 
Communications Corporation in the United States and other countries.

Sun, Sun Microsystems, Solaris, and Java are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the United States and other countries.

Pentium is a trademark of Intel Corporation.
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ITIL is a registered trademark, and a registered community trademark of the Office of 
Government Commerce, and is registered in the U.S Patent and Trademark Office.

UNIX is  a registered trademark of The Open Group in  the United  States  and other 
countries.

Other company, product or service names may be trademarks or service marks of others.
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